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December 13, 2022 
 

Customer Survey Redesign 
 
 
Path: Organization > Repair Center > Records/ 
Customer Survey 
 

Summary: The Customer Survey page has a new 
look and feel with a clean, easy-to-view appearance.. 

Discussion: 

The Customer Survey Tab remains the say; however, 
users see a more streamlined survey. 

The appropriate Repair Center logo can be displayed 
along with introductory text. Sizing can be narrow 
enough to fit on a phone or expanded for other 
devices. 
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November 29, 2022 
 

Multi-Currency Module Available for WebTMA Plus 
 

 
Path: Accounting > Currency 
 

Summary: The Multi-Currency module allows you to 
view and save currency data in more than one 
currency. 

Discussion: 

Using Multi-Currency settings, you can see commonly 
used currencies in records and reports.  During setup 
in Admin > Client Info / Preferences, you designate a 
Functional Currency for entering data. This standard 
currency can be converted to a different currency. 

The Currency > Identity Tab includes settings for the 
currency symbol and the other options that apply to 
the way different currencies display. The ISO Code is 
required to assure accuracy in Currency reports. 

The Currency / Exchange Rates Tab is used to enter 
and edit other currencies with the latest exchange 
rate. Entries on the Tab are required to convert the 
Functional Currency to a different currency. 
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November 8, 2022 
 

Import AutoCAD Changes to WebTMA Using New Module 
 

 
 

 
Path: Admin > CAD Import 
 

Summary: If you use AutoCAD drawings in your 
organization, you can import changes made to your 
drawings and update the related WebTMA Area 
records. 

Discussion: 

AutoCAD licensed users who have the WebTMA-CAD 
plug-in installed can purchase a license for the new 
module. In addition to the Space Management 
WebTMA license, you need users with appropriate API 
permissions to import the changes. 

When all requirements are met, you can link your 
AutoCAD floor plans to WebTMA. 

When floor plans are updated in AutoCAD, you can 
export the data to WebTMA and review details before 
you decide to update any Area records in WebTMA. 

 

Inspection Findings Module Added to Capital Planning 
 
 
Path: Transactions > Request > Inspection Findings 
 

Summary: Inspection Findings allows you to perform 
Safety and Condition assessments that can be 
translated into Projects, Audits, and Work Orders. 

Discussion: 

Inspection Findings is similar to the Request Log 
window, but Inspection Findings have their own list of 
Request Types. 

To make a new Request Type available in the 
Inspection Findings window, go to Lookups > Request 
Type and mark the Inspection Findings check box. 
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October 25, 2022 
 

 

GIS Module ArcGIS Maps Provide Better Experience 
 
 

 
Path:  File > GIS Map View 

 
Path: Admin > GIS > GIS Map 
 

Summary: You can set up your ArcGIS credentials 
from Admin > GIS > GIS Map. 

Discussion: 

Integration with ArcGIS provides you with a more 
customized GIS Map experience. ArcGIS enables you 
to add more features and imagery to your map to 
better meet the needs of your organization. 

NOTE: In order for ArcGIS Map View to function 
properly, map settings must be configured in Admin 
> GIS > GIS Map. 

 

Budget Code Fields Added for Three Universal Interface 
Import/Export Transactions 
 
 

 
 
 

Summary: Budget Code is now a selection in the 
column Entry flyout of the optional Universal 
Interface module for some Transaction Types. 

Discussion: 

A Budget Code field was added to the flyout that 
opens if you select Add Item for Purchase 
Requisitions or Add Purchase Order Line for Purchase 
Orders. The field was also added to the Lookups > 
OTP Types window. 

Budget Code is now a selection in the column Entry 
flyout of the optional Universal Interface module for 
the following Transaction Types: 

• UPI - Purchase Order Import 

• UPI - Purchase Requisition Export 
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• UPI - Receivings Export 
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October 11, 2022 
 

 

End (or Review) Login Sessions Using New Session Log Tab 
 

 
Path: Admin > Client Info / Session Log Tab 
 

Summary: View or end a user’s login session from 
this new tab in Client Info. 

Discussion: 

The Session Log Tab displays historical (inactive) and 
current (active) login sessions. Active logins do not 
display a date in the Session End column. 

Filter the lines using the fields at the top of each 
column. 

Use the Clear Session link in the right-most column 
to end an active session, i.e., log out the user. When 
you select the link, the Session Log Message flyout 
opens to accept your notes on the reason the session 
was ended.  

The message displays in the Notes column. The notes 
can be revised, and the new text replaces any 
existing notes. If an active session is cleared, the 
person will have to log in once more to use the 
application. 

A Last Login List report is available from Reports > 
Report Manager / Management. It displays logins 
based on the number of days since the user last 
logged in to the application. 

 

More Columns Added to Requestor Login Status 
 
 
Path: Request Status Browse 
 

Summary: The redesigned Requestor Login Status 
window now has additional columns that can be 
selected to display in the My Work History Section. 

Discussion: 

The following columns can be added to the display if 
needed: 

• Labor Cost 

• Material Cost 

• Other Cost 

• Total Cost 

• Priority 

 

 



  7 

September 27, 2022 
 

 

Added My Dashboard Control to Open WebTMA Windows in Add Mode 
 

 
Path: My Dashboard  
 

Summary: A new Add Item Control gives you a 
quick way to open frequently-used windows in Add 
mode. 

Discussion: 

System Administrators can easily create these new 
controls. All that is needed is that you add a Name, 
which displays as the title of the control, and select 
the desired window. The example at left opens the 
Work Order window. 

Once the new control is saved to a Tab, the user can 
choose the icon and open the window in Add mode – 
on a separate browser tab. 

 

Enhanced Scheduler Options to Print Work Orders  
 

 
Path: Transactions > Time Manager > Scheduler 
 

Summary: You now have several options to print 
Work Orders from the Scheduler window. 

Discussion: 

When you select the Save button on the Schedule 
Entry flyout as well as Save on the WebTMA toolbar, 
a message pops up with the option to print. 

In addition, you have a Print link on the Action Menu. 

 

Added Option to Hide Columns on Material Request Grid 
 Summary: System Administrators now have the 

option to show or hide grid columns for Material 
Requests. This applies to both Requestor Login and 
regular Login windows. 

Discussion: 

Previously, System Administrators could amend the 
Material Request Entry flyout in the Pages Section 
and hide fields such as Unit Cost. However, they 
could not hide the corresponding column in the grid 
on the Material Request window. 

With this addition to System Form Attributes, 
columns can be hidden as well. 
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Path: Admin > Form Attributes > System Form 
Attribute / Material Request – Material Requests 
 
 

In the Grids Section, expand the Material Request 
Lines (Grid) and clear the Visible check box for 
columns that you do not want your users to see. 
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September 13, 2022 
 

 

Requestor Login Status Browse Enhanced 
 

 
Path: Request Status Browse 
 

Summary: The Requestor Login Status window has 
been redesigned with dashboard features that make 
it easier to use and more informative. 

Discussion: 

The new design has only two Sections. The upper 
Section, My Numbers, shows values for the options of 
your choice. You make the selections when you 
choose the gear icon at the upper left. 

Select a value of interest to view a flyout that shows 
each item. Buttons at the bottom of the flyout allow 
you to export to Excel. 

The My Work History Section is made up of a number 
of columns that can be sorted using the standard 
ascending/descending or filtered using the filter icon 
for specific searches. More columns may be added in 
the future. 

NOTE: System Administrators have the option to add 
or remove controls in My Numbers or columns in My 
Work History using System Form Attributes. 

 

GIS Map View Added 
 

 
Path: File > GIS Map View 
 
 

Summary: The new optional GIS module is a search 
tool to visualize your work orders and maintenance-
worthy items on a map. 

Discussion: 

If your data is in a specific area, such as a city, the 
map zooms to that area when it opens. 

By default, you see a Street view that includes 
records for Area, Asset, Biomed, Building Equipment, 
Facility, Work Order, and Vehicle. You have the 
option to clear some check boxes to filter the number 
of records represented or to change the view. 

The different views (Street, Topographic, etc.) stem 
from the underlying Esri mapping software. 

The various colored circles with values give you at-a-
glance understanding of how many markers make up 
a cluster on the map. Green is a lower number and 
moves up to yellow or red. 

Select a circle to see the markers. Choose the 
markers to view underlying information such as a list 
of work orders or an item record. 
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On the work order list, click a line to open the record. 

For items or locations, click the Go To Record tab. 

Note that the location or item records require entries 
for Latitude and Longitude to display on the map. 

 

Added Ability to Import Latitude & Longitude Fields for MWI 
 
 
Path: Organization > Asset > Records 
Path: Organization > Biomed > Records 
Path: Organization > Entity 
Path: Organization > Equipment > Records 
Path: Material > Tools > Records 
 
 
 

Summary: To support the new GIS module, 
Longitude and Latitude fields are now available in the 
Export Template for import to the core maintenance 
worthy item windows. 

Discussion: 

You can now mass load Latitude and Longitude 
information that allows you to view the location of 
maintenance worthy items on the graphical maps. 
which are available in the system. 

The Export Template Excel file now includes columns 
for Longitude and Latitude. The new columns are 
available from the following windows: 

• Asset 

• Biomed 

• Entity 

• Equipment 

• Tools 

 

Service Request Form Has New Selectable Field 
 

 
Path: Admin > Form Attributes > Service Request 
Form / Layout Tab 
 
 

Summary: Floor Description has been added to the 
Layout Fields flyout. 

Discussion: 

As you edit or create a Request Form, a new field, 
Floor Description, is now available on the Layout 
Fields flyout. 
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Keys Access Tab and Keys Related to Locks 
 
Path: Material > Key Management > Keys / Access 
Tab 
 
 
 

Summary: Keys that are added to Lock window 
records display on the Keys / Access Tab. 

Discussion: 

When you delete the Key from the Lock window, the 
Key is removed from the Keys / Access Tab as well. 

 

Executive Dashboard Digital and Dial Icons 
 

 
Path: My Dashboard 
 

Summary: Icons are easy to add or remove from the 
display. They provide at-a-glance signifiers about the 
control. 

Discussion: 

When you  choose the  graphic button on the 
Configuration flyout, WebTMA provides several pages 
of icons for your selection. With one click, the icon 
displays on the flyout. 

Icons are removed just as easily. Simply select the 
 red cancel icon at the upper left of the first drop-

down page of icons. 
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August 23, 2022 
 

 

Room Inspections Module Added 
 
 
Path: Areas > RI windows 
 

Summary: Inspect rooms at your Facility and record 
the presence and condition of assets. 

Discussion: 

The Room Inspections module is an electronic 
solution designed to allow you to design your own 
inspection points and values. Create multiple 
inspection forms unique to every type of room, 
record the results, and analyze them quickly. 

The module can be used by university housing 
departments to automate move-in and move-out 
inspections as well as by physical plant departments 
that make condition or safety inspections. 
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August 2, 2022 
 

 

Maintenance Only 
The August 2, 2022 release of WebTMA 7 is for maintenance only. There are no enhancements or new 
features. 
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July 19, 2022 
 

 

Maintenance Only 
The July 19, 2022 release of WebTMA 7 is for maintenance only. There are no enhancements or new features. 
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July 12, 2022 
 

 

Maintenance Only 
The July 12, 2022 release of WebTMA 7 is for maintenance only. There are no enhancements or new features. 
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June 21, 2022 
 

 

Distributions to Closed Work Orders Enhanced 
 

 
Path: Material > > Purchase > Purchase Orders > 
Add Distribution–Distribution Entry 
 

Summary: Distribution Entry flyout drop-down 
respects decisions made by System Administrator 
regarding open distributions on closed Work Orders. 

Discussion: 

If your organization allows  purchase distributions to 
remain open on closed Work Orders, the Material > > 
Purchase > Purchase Orders > Add Distribution–
Distribution Entry flyout has been altered to display 
both open and closed Work Orders in the selection 
window.  

If distributions are not allowed on closed Work 
Orders, the selection list does not display closed 
Work Order numbers. 

 

 

UPI – AP Invoice Export / AP Payment Import Added to Universal Interface 
 
 
 
 
 
 
 
 
 
 

Summary: A separate module to accommodate 
exporting invoices from WebTMA and importing 
payments is available with the purchase of the 
WebTMA IntAPInvoicePayment license. 

Discussion: 

When you have this license, you can see the 
following selections on the Transaction Type drop-
down menu. 

• UPI – AP Invoice Export 

• UPI – AP Payment Import 

In addition to Column lists and other details, you can 
also find examples of JSON elements in the online 
help topic titled UPI-AP Import Export Web Service. 
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June 7, 2022 
 

 

Linked Documents for Work Orders Enhanced 
 

 
 

 
 
 

 
 

 
 

Summary: Many more Linked Documents can 
display with Work Orders in version 7. You have the 
option to suppress the documents from other 
modules if needed. 

Discussion: 

In version 7, the Linked Documents attached to many 
records can display with the Work Order  in addition 
to files added from the Work Order. These are: 

• Locations (Facility, Building, Area, Floor) 

• Items (Equipment, Vehicle, Asset, Group, Tool, 
Entity, Biomed Equipment, IT Equipment, 
Linear Asset) 

• Tasks 

• Request Log 

You have the option to prevent any of the eligible 
Linked Documents from displaying with the Work 
Order. 

When you add a Linked Document to any of the 
eligible records from the list above, the Manage 
Documents flyout includes a check box to Suppress 
from Work Order. The check box applies to all 
Document Category selections except URL. 

If you select Image as the Document Category on the 
Manage Documents flyout as illustrated at left, an 
additional check box is available. Mark the Allow 
Image to Print check box if you want the image to 
print with the Work Order. 

On the Work Order window, WebTMA gives you visual 
cues about the source of a Linked Document. At a 
glance, you can determine whether the linked file is 
from a record other than the Work Order. Linked 
Documents added from the Work Order display the 
Edit  symbol as illustrated at left. 

For titles without an Edit symbol, expand the file title 
to see the source type. 

Open the source record, such as a related Building 
record, and the Edit  symbol is available to allow 
you to edit the Linked Document.  

Any Linked Document on Item, Location, Task, and 
Request Log records can be expanded to indicate the 
suppress status. 
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Files added before this release can be edited to mark 
the Suppress from Work Order check box. If a file 
that was displayed on a Work Order is suppressed, it 
is removed from view after suppression. Be sure to 
refresh the Work Order record if it is open. 

 

 

Report Writer Layout Tab – Changed Default 
 
 
Path: Reports > Report Writer / Layout Tab 
 
 

Summary: The Report Writer / Layout Tab default 
has been changed. 

Discussion: 

Previously, v7 Report Writer / Layout Tab defaulted 
to a List format. The default has changed to Table 
format. 
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May 24, 2022 
 

 

Hard-wired WO Browse Columns 
 
 
Path: Transactions > Work Order > WO Browse 
 
 

Summary: Certain columns will always display with 
a WO Browse query, regardless of user-selected 
columns. 

Discussion: 

WebTMA deems information in the following columns 
as critical: 

 WO# 

 Request Date 

 Task Code 

 Task Desc 

 Tag # 

 Tag Description 

These columns display even if the user has not 
selected them. 
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May 10, 2022 
 

 

 

Batch Update Technician Charge Rates 
 

 
Path: Organization > Repair Center > Trade / Identity 
Tab 
 
 

Summary: A change to the Default Charge field on 
the Trade / Identity Tab gives you the option to 
update Technician records in Batch if they meet 
certain conditions. 

Discussion: 

If you have a number of Technicians with the same 
Trade, you have the option to update the Charge 
Rate for the Technicians in batch when you change 
the Default Charge on the Trade / Identity Tab. 

When you enter a Default Charge, the popup pictured 
at left gives you the option to use a batch update. 

If you click Cancel, no Technician records are 
changed. 

If you click OK, the Technician's Charge Rate is 
changed in either of the following conditions: 

 Update the Technician's Charge Rate when 
their only Trade was just updated. 

 Update the Charge Rate for Technician's with 
multiple Trades when their Preferred Trade 
was just updated. 
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April 26, 2022 
 

 

 

Global Technician, Requestor, and Contractor Change 
 

  
Path: Admin > User Management > Records / 
Identity Tab 
 

 
Path: Admin > User Management > Records / Default 
Tab 
Notice the Global check box has been removed. 
 

Summary: New Set as Global Default check boxes 
have been added to the Identity Tab–Access Section. 
These settings apply to the logged-in user. 

Discussion: 

Previously, a Global check box displayed on the 
Default Entry flyout that opened from the User 
Management > Records / Default Tab. That check 
box has been removed. 

You now have the option to establish a Global Default 
for Requestor, Technician, and/or Contractor on the 
Identity Tab. The new Global settings apply to all 
windows. 

When a Global Default is set, the designated 
Technician, Requestor, or Contractor name displays 
throughout the application in fields with that label. 

This is for your convenience. The name in the field 
can be replaced on any window if needed. 

 

 

Add Default SSO User Group from WebTMA 5 to WebTMA 7 
 
 
 
 

Summary: Just in time provisioning has been added 
to WebTMA 7 SAML.  

You have the option to add a Repair Center from a 
flyout panel.  

Choose Behavior as Create Requestor or Create User. 
A Repair Center grid is available, and you can add 
and save the Repair Center from that grid to the 
respective records. 
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Service Request Form – Field Selection Revised 
 

 
 

 
 
Path: Admin > Form Attributes > Service Request 
Form / Layout Tab 
 
 
 
 

Summary: Select multiple fields for your Service 
Request Layout at one time. 

Discussion: 

The Navigation Panel now displays a single option, 
Add Field. 

Click the link to open the Layout Fields flyout. 

Rather than dragging fields one at a time from the 
Navigation Panel, fields for the Service Request Form 
/ Layout Tab are available in a flyout window.  

You can check all the boxes desired before clicking 
Save on the flyout.  

All the new fields are inserted at the bottom of the 
window where you can click-and-drag to rearrange as 
desired. 

 

 

 

 



WebTMA Release Notes  23 

 

March 31, 2022 
 

 

 

Adjustable Session Timeout with Alert 
 

  
Path: Admin > Client Info / Preferences Tab–Global 
Settings Section 
 
NOTE: WebTMA 7 session timeouts are for your 
security. Unless user are actively working in the 
application for long periods, a short timeout setting is 
advisable. 
 
 

Summary: You have a limited option to set the 
length of timeout sessions. 

Discussion: 

Your System Administrator has the option to set the 
amount of time WebTMA 7 is active before it times 
out.  

The settings in minutes are: 

•  minimum 10 minutes  

•  maximum 120 minutes 

•  default is 60 minutes 

If a user is inactive and within 1-2 minutes of the end 
of their session, a warning message says, "You are 
about to be logged out due to inactivity. Press OK to 
stay logged in."  

Select OK on the message box to renew the session. 

 

Print Icon Added to Toolbar 
 

 
 

 
 

Summary: A Print icon on the Toolbar avoids 
opening Reports on the Navigation panel. 

Discussion: 

The Print Options flyout opens when you click the 
Print icon. 

1. Use the drop-down arrow in the Report Name 
field to select a report tied to the current 
window.  

2. (Optional) Mark the Set As Default Report 
check box to automatically display in the 
report the next time you click the Print icon 
on this window. 

3. Select the desired print output button to 
complete the print. 

For windows that do not have reports, the Print 
button is disabled. 

The Report Writer window includes a Print button to 
print the current report in addition to the Render 
Report link on the Action Menu. 
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PM Meter-Based Recalculation Option Added 
 

 
 

Summary: The Next PM Meter value can be 
recalculated based on the meter Reading added when 
a PM Work Order is closed. 

Discussion: 

An elective check box labeled Meter calculation when 
wo complete is now available for Meter Based PMs. 

Mark the check box if you want the Next PM Meter 
value to be recalculated based on the reading 
entered when the PM work order is closed. 

Readings entered from either the Quick Post Meters 
window or when you click Post Meter Reading on the 
Work Order Action Menu are added to the Meter 
Interval to calculate the Next PM Meter. 

Example: 

Meter Interval = 1000 and Last PM Meter = 2000, 
which would normally show the Next PM Meter = 
3000. 

With the check box marked and the PM is done at 
500, the Next PM Meter value is recalculated and 
automatically entered as 3500 after the work order is 
closed. 

 

 

UDF Field Type Added 
 

 
 

Summary: Added Dropdown List as an additional 
Field Type. 

Discussion: 

The options available in the Field Type list now 
include a Dropdown List. 

 

 

Service Request Location Hierarchy 
 
 
 

Summary: The hierarchy has been changed, and 
Facility it no longer required. 

Discussion: 

The Facility field can now be omitted from a client-
designed Service Request form, and the Building field 
functions without a filter. 

 


